WORKSH

Use the SA-AFM for scanning » Flexible, stand alone design

life science samples, large » Scans any sample size
» Adaptable to inverted microscopes

samples, routine scanning
» Linearized xy piezoelectric scanner

of technical samples, or for ,
» Accommodates widest range of standard AFM probes

nanotechnology research. » All standard modes, including vibrating, non-vibrating, and phase
The SA-AFM is a complete » Direct drive motorized probe approach
system and includes everything » Intuitive LabVIEW-based software for image capture

required for scanning all sizes _ _ ,

Using the industry standard light lever force sensor, all standard
and shapes of samples. It scanning modes are included with the system. Vibrating mode is used

for high resolution and soft samples, while non-vibrating mode can be
used for routine scanning. Also included with the system are phase and
manufacturer’s inverted lateral force modes.

microscopes. Control software, written in LabVIEW, is simple and intuitive to use.
Differing windows walk users through the process: a pre-scan window
helps align the AFM probe, a scanning window aids in acquiring images,
a force position window measures force distance curves, and finally, a
system window assists in altering system parameters.

is easily integrated with all

V1.4
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SA-AFM
MEASUREMENTS

In addition to measuring surface
structure, the SA-AFM is ideal for
modes measurements. For example
these images are of a polymer sample.
The top image is the topography
image and the bottom image is the

phase image, measuring the relative

hardness of the polymer sample.

Surface Texture

Surface texture on polished
and machined surfaces is
readily measured with the
SA-AFM.

With the SA’s flexible stage
design, fixtures for holding
almost any sample shape
can be created.

Once measured, the AFM
images can be analyzed
and standard surface
texture parameters such as
Ra are readily calculated.

D

Polished Surface - 30x30x5 microns

Dimensional

Atomic force microscopes
are capable of

accurately measuring

the dimensions of
semiconductor and

other micro-fabricated
devices. Because the
SA-AFM accommodates Wl ] yaopm
commercially available )
AFM probes, specialized i
probes for metrology
measurements can be
used.
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Calibration reference - 40x40x1 micron

Visualization

One of the most powerful
capabilities of the SA-AFM

is the capability to visualize
surface structure. Although
not easily quantified, the
surface texture of this cell
structure is readily visualized.

Features that may be readily
visualized with the SA-AFM
range in size from a few nm
to a few microns.

Cells - 8x8 microns. Image
measured by Dr. Peter Eaton on
the TT-AFM

M
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SA-AFM STAGE | .

V1.4

High Resolution Z Stage

The direct drive's Z stage controls motion down to 330 nm, assuring
optimal tip approach. Software controls for the Z stage rapidly
move the light lever up and down and regulate the automated probe
approach.

Light Lever Force Sensor

An industry standard light lever force sensor is utilized in the
SA-AFM. The probe holder accommodates the widest range of
commercially available AFM probes. The light lever force sensor can
make measurements in standard modes, including vibrating, non-
vibrating, lateral force, and phase mode.

Video Microscope

The high resolution video microscope has a zoom tube which
allows a field of view between 2 X2 mm and .3 X.3 mm. The video
microscope is essential for aligning the light lever laser, locating
features for scanning, and facilitating tip approach.

XY Piezo Scanner

For XY scanning, linearized piezo electric ceramics utilize real time
feedback control to assure accurate measurements. The multiple
modified tripod design (MMTD) of the xy scanner provides scans with
minimal background bow.

Probe holder

A modular probe holder is used in the light lever force sensor and
held in place with a spring clip. Probes can be replaced in less than
two minutes with the probe exchange tool. Additionally, the probe
holder's spring clip can be used to supply voltages to the AFM probe
for techniques such as conductive AFM.

High resolution 3MP CCD Color Camera Video Microscope
High Performance Linear Z Translator

XYZ Video Microscope Positioning

Linearized X-Y Scanner

Light Lever Force Sensor

Small Footprint High Stability Stage Structure

Large objects that will not fit in a traditional stage may be imaged with the
SA-AFM. In this example, the monitor of a commercial AFM is being imaged.
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WORKS8HOP.

EBOX

Electronics in the SA-AFM are
constructed around industry standard
USB data acquisition electronics. The
critical functions, such as xy scanning,
are optimized with a 24-bit digital

to analog converter. With the analog

z feedback loop, the highest fidelity
scanning is possible. Vibrating mode
scanning is possible with both phase
and amplitude feedback using the high

sensitivity phase detection electronics.

V1.4

24-bit Scan DAC

Scanning waveforms for generating precision motion in the X-Y axis
with the piezo scanners are created with 24 bit DACS driven by a

32 bit micro controller. With 24 bit scanning, the highest resolution
AFM images may be measured. Feedback control using the xy strain
gauges assures accurate tracking of the probe over the surface.

Phase and Amplitude Detector Circuit

Phase and amplitude in the Ebox are measured with highly stable
phase and amplitude chips. The system can be configured to feed
back on either phase or amplitude when scanning in vibrating mode.

Signal Accessible
At the rear of the eBox is a 50 pin ribbon cable that gives access to all
of the primary electronic signals without having to open the eBox.

Precision analog feedback

Feedback from the light lever force sensor to the Z piezoceramic is
made using a precision analog feedback circuit. The position of the
probe may be fixed in the vertical direction with a sample-and-hold
circuit.

Variable Gain High Voltage Piezo Drivers
An improved signal to noise ratio as well as extremely small scan
ranges are possible with the variable gain high voltage piezo drivers.

Microprocessor for scan generation through 24 bit DACs

Low noise, variable gain high voltage amplifiers with PID feedback for
XY scanning

Dimensions: Width 6" | Height 10" | Depth 14"

High fidelity, low noise z feedback circuits for accurate probe tracking
Phase and amplitude detection circuits for vibrating mode AFM
Industry standard National Instruments USB data acquisition board
Internally accessible header for signal input/output

Eight channels of ADC for monitoring and displaying data with
LabVIEW software

1434 East 33rd St., Signal Hill, CA 90755 | P:(714) 402-8253
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WORKS8HOP.

SOFTWARE

Software for acquiring images is
designed with the industry standard
LabVIEW programming visual interface
instrument design environment.
Functions such as setting scanning
parameters, probe approach,
frequency tuning and real time

image display are all standard, and
included with the product. If special
enhancements are needed, LabVIEW's
programming environment facilitates
rapid software development. LabVIEW
standards ensure that the SA-AFM
can be combined with any other

instrument using LabVIEW VI.

V1.4

» Pre-scan Window

1] Ju
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» Scan Window

A pre-scan window presents
users with a logical sequence
to all functions required
before initiating a scan.

Once the steps in the pre-
scan window are completed,
the scan window is used

for measuring images.

Scan parameter, Z feedback
parameters, and image view
functions may be changed
with dialogs on this screen.

There is a tab for measuring
F/D curves in the
AFMWorshop software. Data
is exported to a .csv file for
analysis in standard programs
such as Microsoft Excel™.

LabVIEW is an industry
standard programming
environment for controlling
instrumentation. All the
software for the SA-AFM is
written with LabVIEW and
can be readily customized
for specialized applications.
Any instrumentation already
using LabVIEW can be added
to the SA-AFM to create new
capabilities.

1434 East 33rd St., Signal Hill, CA 90755 | P:(714) 402-8253
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IMAGE
ANALY SIS
SOFTWARE

Included with the SA-AFM is the
Gwyddion open source SPM image
analysis software. This complete
image analysis package has all of
the software functions necessary
to process, analyze and display

SPM images.

Eile
Edit
Daka Process
Graph
Meka
.E| -;-.:'iew

ICRONCEE

[=] [rata Process

a8

V1.4

Visualization: false color representation with different types of
mapping

Shaded, logarithmic, gradient- and edge-detected, local contrast
representation, Canny lines

OpenGL 3D data display: false color or material representation
Easily editable color maps and OpenGL materials

Basic operations: rotation, flipping, inversion, data arithmetic, crop,
re-sampling

Leveling: plane leveling, profiles leveling, three-point leveling, facet
leveling, polynomial background removal, leveling along user-defined
lines

Value reading, distance and angle measurement

Profiles: profile extraction, measuring distances in profile graph,
profile export

Filtering: mean, median, conservative denoise, Kuwahara, minimum,
maximum, checker pattern removal

General convolution filter with user-defined kernel

Statistical functions: Ra, RMS, projected and surface area, inclination,
histograms, 1D and 2D correlation functions, PSDF, 1D and 2D
angular distributions, Minkowski functionals, facet orientation
analysis

Statistical quantities calculated from area under arbitrary mask
Row/column statistical quantities plots

ISO roughness parameter evaluation

Grains: threshold marking and un-marking, watershed marking

Grain statistics: overall and distributions of size, height, area, volume,
boundary length, bounding dimensions

Integral transforms: 2D FFT, 2D continuous wavelet transform (CWT),
2D discrete wavelet transform (DWT), wavelet anisotropy detection

Fractal dimension analysis

Data correction: spot remove, outlier marking, scar marking, several
line correction methods (median, modus)

Removal of data under arbitrary mask using Laplace or fractal
interpolation

Automatic xy plane rotation correction
Arbitrary polynomial deformation on xy plane
1D and 2D FFT filtering

Fast scan axis drift correction

Mask editing: adding, removing or intersecting with rectangles and
ellipses, inversion, extraction, expansion, shrinking

Simple graph function fitting, critical dimension determination
Force-distance curve fitting

Axes scale calibration

Merging and immersion of images

Tip modeling, blind estimation, dilation and erosion

WEOBKEHDE 1434 East 33rd St., Signal Hill, CA 90755 | P: (714) 402-8253
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WORKS8HOP.

VIDEO
MICROSCOPE

A video optical microscope in an AFM
serves three functions: aligning the
laser onto the cantilever in the light

lever of the AFM, locating surface
features for scanning, and facilitating
probe approach. The SA-AFM includes
a high performance video optical
microscope along with a 3 mega pixel

CCD camera, light source, microscope

stand, and Windows software for

displaying images.

PROBE HOLDER/
EXCHANGE

The SA-AFM utilizes a unique probe
holder/exchange mechanism. Probes
are held in place with a spring device

that mates with a probe exchange tool.
This combination makes changing

probes fast and easy on the SA-AFM.

MODES

Standard with every SA-AFM are non-
vibrating (NV) mode and vibrating (V)
modes for creating topography scans.
Additional modes included with the
product are lateral force imaging and
phase mode imaging. Any scanning
mode that can be implemented with

a light lever AFM is possible with the
SA-AFM.

V1.4

The video microscope is used to locate
surface features for scanning. The vibrating
mode probe cantilever shown here is 125
microns long. The sample is a reference for
conductive mode AFM which has several
electrodes that come together in the center.

Laser alignment is greatly facilitated

with the video optical microscope. With a
resolution of 1.5 it is possible to directly
visualize the position of a laser spot on the
cantilever. The video optical microscope

is also used to increase the rate of probe
approach. It is possible to estimate the
distance between a sample and probe by
focusing first on the sample and then on
the probe.

Probe Holder
Probe Inserted in Clip

Probe Exchange Tool
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With the window above the resonance frequency of a cantilever is readily
measured. Additionally, the phase characteristics of the probe-sample

interaction may be captured.
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SPECIFICATIONS

» 40 Micron xyz Scanner
» Type
» xy Linearity
» xy Range
» Xy Resolution

» xy Actuator type
» Xy Sensor type
» z Range

» z Linearity

» z feedback noise
» z Actuator Type
» z Sensor type

P> Light Lever AFM Force Sensor
» Probe Types
» Probe Insertion

» Probe Holding Mechanism

» Laser/Detector Adjustment Range
» Adjustment Resolution
»  Minimum Probe to Objective
» Laser Type
» Laser Focus
» Detector
Type
Band Width
Signals Transmitted
Gain
» Probe sample angle

p Digital Data Input Output

» Connection

» Scanning DAC
Number
Bits
Frequency

» Control DAC
Number
Bits
Frequency

» ADC
Number
Bits
Frequency

V1.4

Modified Tripod
<1%

> 40 p

< 3 nm closed loop
< 0.3 nm open loop
Piezo

Strain Gauge Th
>7u

<5%

<0.15 nm*

Piezo

None

Industry Standard
Manual

Probe Exchange Tool
Clip

Vibrating Mode Piezo
Electrical Connector
to Probe

+/-1.5mm

1 micron

25 mm

670 nm Diode, < 3 mW
<25 microns

4 Quadrant

> 500 kHz

TL,BL, TR, BR
Low, High Settings
10 degrees

USB

24
7 kHz

14
2 kHz

14
48 kHz

» Z Motion
» Type
» Range
» Drive Type
» Min. Step Size
» Slew Rate
» Limit Switch
» Control

» Analog Electronics

» Vibrating Mode
Freq Range
Output Voltage
Demod. Freq

» Z Feedback
Type
Bandwidth
Sample Hold
Voltage

» xy Scan
Voltage
Bandwidth
Pan & Zoom

»  Tip Approach Cutoff

» Software
» Environment
» Operating System
» Image Acquisition

» Control Parameters
PID
Setpoint
Range
Scan Rate
Image Rotate

» Laser Align

» Vibrating Freq. Display

» Force Distance

» Tip Approach

» Oscilloscope

» Image Store Format
» Image Pixels

» H.V. Gain Control

» Real Time Display

» Calibration
» Probe Center

Direct Drive

25 mm

Stepper Motor

330 nm

8 mm/minute

Top, Bottom

Software - Rate, Step Size

2 kHz — 800 kHz
10 Vpp
TBD

PID
> 3 kHz
Yes
0-150V

0-150V
> 200 Hz
22 Bits

< 20 p sec.

LabVIEW
Windows 7

Real Time Display
(2 of 8 channels)

Yes

Yes

Yes

Yes

0 and 90 degrees

Yes

Yes

Yes

Yes

Yes

Industry Standard
16 x 16to 1024 x 1024
xy and z

Line Level, Light Shaded,
Grey Color Palette
System Window

Yes

WEORKEHDE 1434 East 33rd St., Signal Hill, CA 90755 | P: (714) 402-8253
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SPECIFICATIONS coiiues

p Video Microscope

Field of view 2x2mm 300x300u
Resolution 20 p 1.5
Working Distance 114 mm 114 mm

Magnification 45X 400X

> Computer
» Industry Standard Computer & Monitor
(laptop available upon request)
» Windows 7
» AFMWorkshop LabVIEW .exe installed

V1.4

p Stage
a g »
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Back and side view of the SA-AFM stage without the AFM/video
microscope. The feet at the bottom may be removed if the stage
is rigidly mounted to a surface.

*Z Noise performance depends greatly on the environment in
which the SA-AFM is used. Best Z noise performance is obtained in
a vibration free environment.

** Every effort is made to present accurate specifications;
however, due to circumstances out of the AFM Workshop's control,
specifications are subject to change.
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